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LESSON 1 -  
GETTING STARTED  
 

WORKING WITH WORD WINDOWS 

 Discussion 
When upgrading from Word 97, the first feature you notice is the new interface. The Word 2002 
interface has a new look and feel. To the right of the document area is the task pane. The New 
Document task pane provides links for opening new or existing documents. 
 
You can ask the Office Assistant for help by typing a question in the Ask a Question box at the far 
right of the menu bar. This feature provides a fast, always-visible method of getting help. It is better 
to enter a full question or sentence rather than just a word or phrase. 
 
Word 2002 now includes an Office Clipboard that can hold multiple items. You no longer have to 
complete the copy and paste operation before copying another item. As you copy items, they appear 
on the Clipboard task pane. You can gather multiple selections and then paste them as desired. 
 
Several documents can be open at the same time, with each document displaying its own application 
title bar, menus, toolbars, scroll bars, and status bar. Open documents appear as buttons in your 
taskbar. The Search task pane is also available to perform simple or advanced file searches. 
 
Word 2002 includes many enhancements to make working with documents easier and more 
professional looking. 
 
Formatting and consistency are made easier through task panes. Use the Reveal Formatting task 
pane to display text formatting, such as font style, paragraph alignment, and section settings. The 
Reveal Formatting task pane also provides links to various formatting dialog boxes, giving you the 
ability to open a dialog box with a single click. In the Styles and Formatting task pane you can 
view, select, apply, and clear formatting from text. You can also use this task pane to select all the 
text of a similar style, allowing you to select non-contiguous text. 

 

USING THE TASK PANE 

 Discussion 
The task pane provides links to many common tasks in Word. For example, you can use the task 
pane to create a new, blank document or to reopen a recently modified one. 
 
The task pane is actually comprised of several panes, which can be selected from the Other Task 
Panes list. The name of the current pane appears in the task pane title bar. You can use other task 
panes to find and insert clip art, search for files, and create and apply styles. 
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The Back and Forward buttons located in the task pane title bar navigate to previously viewed task 
panes. Blue text in the task pane indicates a link to an action or dialog box. 
 
You can hide or display the task pane according to your needs. Although the features in the task pane 
are useful, you may want to hide it to display a larger document area. By default, the task pane 
appears each time you start Word. You can disable this feature by deselecting the Show at startup 
option at the bottom of the New Document task pane. 
 

  

 
The contents of a task pane vary, depending upon the currently selected text 
or object. 

  

 
Each task pane can be opened with a separate menu command. The Task 
Pane command on the View menu opens the most recently used task pane. 

  

 
You can change the size of the task pane by dragging the splitter bar (the 
border between the vertical scroll bar and the task pane) as needed. 

  
 

 Procedures 

1. If necessary, select the View menu to open the task pane. 

2. Select the Task Pane command. 

3. To view a different task pane, select the Other Task Panes list on the task pane 
title bar. 

4. Select the desired task pane. 

5. Click the Back or Forward button to return to a previous task pane. 

6. To close the task pane, click the Close button in the upper, right corner of the task 
pane. 

7. Display the task pane again, if desired. 

 
 
 

USING ASK A QUESTION TO GET HELP 

 Discussion 
The Ask a Question box at the far right of the menu bar provides a fast, always-visible method of 
getting help. Like the Office Assistant, it is better to enter a full question or sentence rather than just 
a word or phrase. After typing the question and pressing the [Enter] key, Word suggests possible 
help topics. Clicking any suggestion opens the Microsoft Word Help dialog box to the corresponding 
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topic. Once the Microsoft Word Help dialog box is open, you can navigate to other relevant help 
topics. 
 
When you first open Word, the Ask a Question box displays the default prompt Type a question 
for help. Your question text replaces the prompt. The Ask a Question list displays your previous 
questions. You can use the list to select or review recently asked questions. Questions entered into 
the Office Assistant and the Answer Wizard also appear in the list. 
 

  

 
The Ask a Question list only displays the questions asked during the 
current editing session. Closing Word clears the list. 

  

 
If there are more topics than can be displayed at one time, you can use the 
See more and the See previous commands to scroll through the available 
topics. 

  
 

 Procedures 

1. Click in the Ask a Question box on the menu bar. 

2. Type the question you want to ask. 

3. Press [Enter]. 

4. Select the desired help topic. 

5. Click the Close button on the help window title bar. 

 



 

 

LESSON 2 -  
USING NEW FILE FEATURES  
 

USING THE OPEN DIALOG BOX 

 Discussion 
The most significant change in the Open dialog box is that it is now a resizable window. Other 
changes include the Places Bar, which appears on the left side of the dialog box. The Places Bar 
provides shortcuts to various folders containing commonly used files, as well as desktop options and 
recently opened files. 
 
The Views button at the top of the Open dialog box allows you to select one of eight views: Large 
Icons, Small Icons, List, Details, Properties, Preview, Thumbnails, or WebView. The 
Thumbnail view displays a miniature image of supported graphic and HTML files. You can change 
views using the Views list or by repeatedly clicking the Views button to cycle through the available 
views. 
 
The Open button now provides a list of options that allow you to open a document as read-only, 
open a copy of a document, open an HTML file in your browser, or open and repair a damaged file. 
 

  

 
You can also access the Open dialog box by selecting the More documents 
link in the New Document task pane. 

  

 
If you use the Favorites folder to quickly locate files, you can open it using 
the Favorites icon on the Places Bar. You can access the Add to Favorites 
command from the Tools menu in the Open dialog box. 

  
 

 Procedures 

1. Click the Open button  on the Standard toolbar. 

2. Select the Look in list. 

3. Select the drive where the document you want to open is located. 

4. Open the folder in which the document you want to open is located. 

5. Click the arrow on the Views button . 

6. Select the desired view. 



 

VU Instructional Technologies Page 9 
 

7. Select the file name of the document you want to open. 

8. Select the Open list. 

9. Select the desired option. 

 
 
 

USING THE MY PLACES BAR IN THE OPEN DIALOG BOX 

 Discussion 
When in the Open dialog box, you may notice a bar containing icons on the left-hand side of the 
window. This is called the My Places Bar. The My Places Bar contains shortcuts to commonly-used 
folders, such as My Documents, My Network Places, Favorites and History, the latter of which is 
a history of the last places that you went to open or save a file. 
 
You can add items to the My Places Bar, such as a shortcut to your A: and D: drives or to one or 
more of your mapped network drives (such as M:, H: or S:). 
 
You can also remove items from the My Places Bar if you don’t use them. 
 
Finally, if you add too many items to the My Places Bar and it becomes overcrowded, you can tell 
the program to show the items as Small Icons so that you can see all of them at once. You can even 
move items around on the My Places Bar. 
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 Procedures 

1. Click Open from the File menu (or click More Documents from the New Document 
Task Pane). 

2. To add a folder to the My Places Bar, navigate to that folder and select the folder. Then 
click the Tools button on the toolbar to the right of the Look in box. Select Add to 
“My Places.” The folder will be added to the My Places bar.  

3. To add a drive to the My Places Bar, click on the drop-down arrow next to the Look in 
box and select My Computer. Click once on the drive that you want to add and then 
click the Tools button on the toolbar to the right of the Look in box. Select Add to 
“My Places.” The drive will be added to the My Places bar.   

4. To make the icons on the My Places Bar smaller, right-click on the My Places bar and 
select Small Icons. To return to large icons, right-click on the My Places Bar and 
select Large Icons. 

5. To delete an item from the My Places Bar, right-click on the item and select Remove. 

6. To rename an item on the My Places bar, right-click on the item and select Rename. 
Type the new name and hit enter. 

7. To move and item up or down on the My Places Bar, right-click on that item and select 
either Move Up or Move Down. 

 
 

USING THE NEW DOCUMENT TASK PANE 

 Discussion 
When you open Word 2002, a new, blank document and the New Document task pane appear in the 
application window. The New Document task pane contains four sections; Open a document, New, 
New from existing document, and New from template. Links in each section allow you to create a 
new, blank document, create a new document from an existing document, open a recently opened 
document, and create a document from a template. 
 

  

 
Deselecting the Show at startup option at the bottom of the New 
Document task pane disables the task pane so that it does not automatically 
appear when you open Word. 

  

 
Word displays the names of the four most recently opened documents at the 
bottom of the File menu and in the Open a document list at the top of the 
New Document task pane. You can use the General page in the Options 
dialog box to change the number of documents that appear in the list. 
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Clicking the New button on the Standard toolbar opens a new document 
and bypasses the New Document task pane. You can also create a new, 
blank document by clicking the Blank Document link in the New 
Document task pane. 

  
 

 Procedures 

1. Select the File menu. 

2. Select the New command. 

3. Select the desired link. 

 

USING A TEMPLATE 

 Discussion 
The New Document task pane allows you to access any of Word’s preformatted templates 
(including templates for memos, reports, letters, and brochures) or any template you may have 
created. The New Document task pane includes links to templates available in the Templates dialog 
box, previously used templates, and templates stored on a web site, such as those available on the 
Microsoft Web site. 
 

  

 
Links to recently used templates appear in the New Document task pane 
under the New from template section. 

  

 
To delete a template, click the General Templates link in the New 
Document task pane. Then, in the Templates dialog box, right-click the 
template you want to delete and select the Delete command. 

  
 

 Procedures 

1. Select the File menu. 

2. Select the New command. 

3. Select the desired template link in the New from template section of the New 
Document task pane. 

4. Select the tab or links as necessary, to locate the template you want to use. 
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5. Select the desired template. 

6. Select OK. 

 

USING THE BASIC SEARCH TASK PANE 

 Discussion 
Word includes a Search task pane that you can use to locate files. The Search task pane actually 
involves three separate task panes; the Basic Search task pane, the Advanced Search task pane, and 
the Search Results task pane. 
 
If you are unsure of the file name of a document or do not know where the document is located, you 
can use the Basic Search task pane to locate it. When you enter text into the Search text box, Word 
searches for those characters in file names, document text, and text fields in Properties dialog boxes. 
 
You can expand or limit a search using the location and file type options under Other Search 
Options. You can search every available folder by selecting Everywhere from the Search in list 
and Anything from the Results should be list. Conversely, you can limit a search to specific folders 
or file types using the corresponding options. 
 
When a search is performed, Word displays the found files on the Search Results task pane. You 
can click the Stop button at the bottom of the task pane at any time to stop the current search. The 
search is complete when the Stop button changes to Modify. If the file for which you are looking is 
not found, you can use the Modify button to modify the search or to create a new one. 
 
Pointing to a file name in the Search Results list displays a ScreenTip, which lists the file properties. 
Clicking the file name opens it in Word. A list of options appears when you right-click a file name in 
the Search Results task pane or click its drop-down arrow. These options include opening the file, 
opening a copy of the file with a new name, copying a file link to the Clipboard, or opening the file’s 
Properties dialog box. 
 
Your search text is saved in the Search task pane for the entire Word session; but it is cleared when 
you exit Word. However, your selections under Other Search Options are permanently saved until 
you manually change them. 
 

  

 
You can use the Search button on the Standard toolbar to display and hide 
the Search task pane. If the task pane is already displayed, you can also 
select the Search task pane from the drop-down list in the task pane title 
bar. 

  

 
You can perform a basic search from the Open dialog box by selecting the 
Tools menu, the Search command, and the Basic Search tab. 
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 Procedures 

1. Click the Search button  on the Standard toolbar. 

2. Select the Basic Search link at the bottom of the task pane, if necessary. 

3. Select the Search text box. 

4. Type the text you want to find. 

5. To modify where to search, click the Search in arrow. 

6. Click the plus sign next to each location you want to expand. 

7. Select and deselect the check boxes to the left of each folder you want to include 
or exclude from the search.  

8. Press [Esc]. 

9. To modify what to search, click the Results should be arrow. 

10. Select or deselect the check box to the left of each file type you want to include or 
exclude from the search.  

11. Press [Esc]. 

12. Select Search. 

 
 

USING THE DOCUMENT RECOVERY PANE 

 Discussion 
Office XP provides a file recovery feature to recover data lost when an error prevents the normal 
saving and closing of a file, such as when your computer suddenly crashes or loses power. The next 
time you start Word after a system halt, the Document Recovery pane appears on the left side of the 
application window with a list of all documents that were open when the error occurred. For each 
document, the task pane shows the file name and when you last saved the document. If the document 
is marked as recovered, then it is probably a more recent version of the original document than the 
last saved version. 
 
Pointing to document in the Document Recovery pane displays a drop-down arrow, from which you 
can choose a recovery option. The Open option opens the recovered file. The Save As option allows 
you to save the recovered file with a new name. If you save the file with the same name, the original 
file is overwritten. If the document is marked as recovered, you can select the Delete option to delete 
the recovered file or the Show Repairs option to view the repairs that were made to the file. 
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CREATING ADOBE PDF FILES 
 

 Discussion 
Your new computer has the Adobe Acrobat 5.0 program installed on it, giving you the ability to 
create Adobe pdf files via Microsoft Word, Excel, PowerPoint, etc. A benefit of creating a pdf file is 
that the program takes something like a “picture” of the document on your screen so that you can 
share that document with others without requiring them to have MS Word on their computer. All 
they need to view your pdf file is the Adobe Acrobat Reader, which is a free program that can be 
downloaded from the Adobe website at www.adobe.com. 
 
Another benefit of creating pdf files is that the file you create will look exactly as you created it on 
anyone’s machine, regardless of the configuration of the viewer’s computer. This is useful when you 
are sharing files with those who have different versions of Word or different printers than you do, 
both of which may change the formatting of your document and make it look different than when 
you created it. With pdf files, what they see is what you see. 
 
Adobe pdf files are created within the software program that you created the file in. In other words, 
if you want to make a pdf file out of a Word document, you should do it from within MS Word. 
 

 Procedures 

1. Create the Word document and save it. 

2. Click the Print icon on the Standard Toolbar (or select File, Print). 

3. Change the printer Name to the Acrobat Distiller (NOT the Acrobat PDFWriter). 

4. Click OK. If you had not saved the document, you will be asked to. 

5.  You will be asked what you want to name the pdf file and where you want it to be 
saved. Name the file and select a location (My Documents is NOT the default 
location for pdf files, so select My Documents). 

6. Adobe Acrobat may take a few moments to open up, but you will see it open up 
on the Taskbar. You can click on the Adobe program on the Taskbar, but you 
must wait for the file to finish being created.  

7. Once the pdf file is created, it will appear within the Adobe Acrobat program for 
you to view. There is no need to save the file. You can simply close it. It has 
already been saved in the location that you selected during the creation of the file. 



 

 

LESSON 3 -  
USING NEW DOCUMENT FEATURES  
 

SELECTING MULTIPLE TEXT BLOCKS 

 Discussion 
A new Word 2002 feature allows you to select and format multiple, non-contiguous text selections 
concurrently. The [Shift] key allows you to extend a selection in a continuous block, and the [Ctrl] 
key allows you to select multiple, non-contiguous text blocks. 
 

 Procedures 

1. Select a contiguous text block. 

2. To select additional, non-contiguous text blocks, hold [Ctrl] and select the desired 
text. 

 

USING THE PASTE OPTIONS BUTTON 

 Discussion 
The Paste Options button, which appears after you have pasted a cut or copied item, allows you to 
apply the desired formatting to the pasted item. For example, if you are copying bolded text, you 
may want to paste the text without the bolding. 
 
If you select the Keep Source Formatting option, the text is pasted with its original formatting. 
When the Match Destination Formatting option is selected, the formatting in the paste location is 
applied to the pasted text. The Keep Text Only option pastes the text without its original formatting, 
and the Apply Style or Formatting option opens the Styles and Formatting task pane. 
 
Paste options may differ, depending upon the format of the cut or copied text. For example, different 
options will appear when you paste a list that uses automatic numbering. 
 
You can hide the Paste Options button by pressing the [Esc] key. 
 

  

 
The Paste Options button can be turned off by selecting the Tools menu, 
the Options command, and the Edit page and then deselecting the Show 
Paste Options buttons option under Cut and paste options. 
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 Procedures 

1. Select the text you want to move or copy. 

2. Cut or copy the text as desired. 

3. Position the insertion point in the location where you want to paste the text. 

4. Click the Paste button . 

5. Click the Paste Options button . 

6. Select the desired option. 

7. To hide the Paste Options button, press [Esc]. 

 

USING THE CLIPBOARD TASK PANE 

 Discussion 
The Office Clipboard can store multiple items, including graphics, cut or copied from any open 
Office application. The cut or copied items are then available to be pasted into any open Office file. 
 
The Office Clipboard is accessed by opening the Clipboard task pane. When you first open the 
Clipboard task pane, it displays the last item cut or copied to the Windows Clipboard. As you 
continue to cut or copy items, they are collected on the Clipboard task pane and remain available to 
all Office XP products. 
 
For each of the cut or copied items, the Clipboard task pane displays an icon and a portion of the 
text. You can click any item to paste it at the insertion point, or you can use the Paste All button to 
paste all the items at one time. Right-clicking an item displays a shortcut menu containing options to 
paste or delete the item. 
 
After pasting text, the Paste Options button appears in the document, allowing you to control the 
formatting of the pasted item. 
 
Once you have finished a particular copying sequence, you can clear the Office Clipboard of all 
items by clicking the Clear All button in the Clipboard task pane. In addition, the Office Clipboard 
clears automatically when you close all Office XP programs. 
 

  

 
If the task pane is open, you can display the Clipboard task pane by 
selecting the Clipboard command from the Other Task Panes list on the 
title bar. 
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You can also open the Clipboard task pane by pressing [Ctrl+C] twice, 
since the Clipboard task pane opens automatically as soon as a second item 
is cut or copied. 

  
 

 Procedures 

1. Select the Edit menu. 

2. Select the Office Clipboard command. 

3. To clear all the items from the Office Clipboard, click the Clear All button in the 
Clipboard task pane. 

4. Cut or copy the items you want to paste. 

5. Position the insertion point where you want to insert an item. 

6. Click any item in the Clipboard task pane to paste it into the document at the 
insertion point. 

7. To paste all the items, click the Paste All button in the Clipboard task pane. 

8. To remove an item from the Office Clipboard, right-click it in the Clipboard task 
pane. 

9. Select the Delete command. 

 

CHANGING OFFICE CLIPBOARD OPTIONS 

 Discussion 
The Options button in the Clipboard task pane allows you to control the functioning of the Office 
Clipboard. By default, the Clipboard task pane opens automatically as soon as two items are cut or 
copied in succession. However, you can deselect the Show Office Clipboard Automatically option 
to suppress the automatic appearance of the Clipboard task pane. 
 
When you close the Clipboard task pane, Word stops collecting cut or copied items. If you want to 
continue collecting items while the task pane is closed, select the Collect Without Showing Office 
Clipboard option. 
 
When the Clipboard task pane is open in any Office XP product, a Clipboard icon appears in the 
Windows system tray. To hide the Clipboard icon in the system tray, you can deselect the Show 
Office Clipboard Icon on Taskbar option. 
 
If you cut or copy an item when the Office Clipboard is open in any Office application, a screen 
prompt automatically appears above your Windows system tray, announcing the current status of the 
Office Clipboard. The status prompt appears even if the Clipboard icon is hidden. You can deselect 
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the Show Status Near Taskbar When Copying option to hide the appearance of this screen 
prompt. 
 

  

 
Closing the Clipboard task pane three times without pasting from it 
automatically disables the Show Office Clipboard Automatically option. 

  
 

 Procedures 

1. Open the Clipboard task pane. 

2. Click the Options button in the Clipboard task pane. 

3. Select or deselect the desired option. 

4. Click in any blank area to close the list of options. 

 

SWITCHING DOCUMENT VIEWS 

 Discussion 
Although the views in Word 2002 have not changed, the names of the views have. 
 
Page Layout view is now called Print Layout view and Online Layout view is now called Web 
Layout view. You can use the View menu or the View buttons to the left of the horizontal scroll bar 
to change document views. 
 
A new feature in Print Layout view is the ability to hide the white space (margins) at the top and 
bottom of the page. To hide the white space, point to the top or bottom edge of the page and click 
when the mouse pointer displays as two arrows and the Hide White Space ScreenTip appears. To 
show the margins again, repeat the process. (The ScreenTip will display the text Show White 
Space.) 
 

  

 
Master Document view is now available in Outline view by selecting the 
Master Document View button on the Outlining toolbar. 
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PRINTING ENVELOPES AND LABELS 

 Discussion 
Word makes it simple to address and print envelopes and labels. The procedures for creating 
envelopes and labels are similar, and both are completed in the Envelopes and Labels dialog box. 
The Envelopes and Labels dialog box now includes an E-postage Properties button that allows you 
to set options for an electronic postage program, if you have one installed. 

  

 
In order to access the Envelopes and Labels command, a document must be 
open. 

  

 Procedures 
1. Select the Tools menu. 

2. Point to Letters and Mailings. 

3. Select the Envelopes and Labels command. 

4. Select the Envelopes or Labels tab, as applicable. 

5. Select the Delivery address box for envelopes or the Address box for labels. 

6. If necessary, type the address, pressing [Enter] after each line. 

7. When creating envelopes, select the Return address box. 

8. Type the return address, pressing [Enter] after each line, if necessary. 

9. Select Options. 

10. When creating envelopes, select the Envelope Options tab, if necessary. 

11. Select envelope or label options as desired. 

12. For envelopes, select the Delivery point barcode option under If mailed in the 
USA, if desired. 

13. Select OK. 

14. For labels, select the Delivery point barcode option, if available and desired. 

15. To print an envelope or a full page of the same label, place the envelope into the 
printer in the direction indicated under Feed or place the label sheet in the selected 
tray; then, select Print. 

16. Alternately, to save the envelope with the current document, select Add to 
Document; to modify or save a sheet of labels, select New Document. 

17. When creating envelopes, select Yes to change the default return address or No to 
retain the current default return address. 

 



 

 

LESSON 4 -  
USING NEW FORMATTING FEATURES  
 

WORKING WITH NEW FORMATTING FEATURES 

 Discussion 
Word 2002 provides several new feature that help with document formatting. The Styles and 
Formatting task pane allows you to apply different paragraph and character styles with a single 
click. You can also select a text sample and choose all instances in the document that use the same 
formatting, allowing you to select and format non-contiguous text en masse. 
 
Bullets and numbering have been improved by the AutoCorrect Options tag that allows you to 
enable or disable numbering, restart the numbering, or continue the numbering from a previous list. 
 
Another new feature is the List Styles found in the Bullets and Numbering dialog box. You can 
create your own bullet and numbering styles and assign different fonts or graphics to each list level. 
 
 

APPLYING FORMATS WITH THE TASK PANE 

 Discussion 
All the formatting combinations you apply to a document are listed on the Styles and Formatting 
task pane. You can use the task pane to easily apply a format. Using the formats in the Styles and 
Formatting task pane can help you keep a consistent look throughout the document. 
 
When you point to a format or style in the Pick formatting to apply list, all of its attributes appear 
in a ScreenTip. Most of the attributes will include the word Normal. The Normal style contains all 
the default font attributes for the document based on the current template. When you use the task 
pane to apply a format, be aware that the formatting of the selected text is removed and all the 
attributes of the new format are applied. Therefore, if you apply a Bold format based on the Normal 
style to text formatted with a font size of 14 points, the font size of the selected text also changes. 
 
In addition to applying formats, you can also find text to which a specific format has been applied. 
Using the shortcut menu for a format, you can select all the instances of that format, remove that 
format from all the instances in the document, or modify the format, thereby creating a new style. 
 

  

 
The Styles and Formatting button is a toggle; you can use it to close the 
task pane as well. 
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You can delete a specific format by right-clicking it in the Styles and 
Formatting task pane and selecting Delete. If you delete a format, all text to 
which it had been applied returns to the Normal style. 

  

 
You can also select the Format menu and the Styles and Formatting 
command to open the task pane. If another task pane is already open, you 
can use the Other Task Panes list to switch to the Styles and Formatting 
task pane. 

  
 

 Procedures 

1. Click the Styles and Formatting button  on the Formatting toolbar. 

2. Select the Show list at the bottom of the task pane. 

3. Select Available formatting or Formatting in use as desired. 

4. Select the text you want to format. 

5. Click the desired format from the Pick formatting to apply list. 

6. To select text formatted identically, select any text containing the formatting you 
want to find. 

7. Click Select All in the Styles and Formatting task pane. 

 

USING CLICK AND TYPE TO ALIGN TEXT 

 Discussion 
The Click and Type feature allows you to insert new text or graphics in one of three preset 
alignment areas in any blank line of a document. If you are creating a special page (such as a title 
page), the Click and Type feature allows you to type the title text in the middle of the page 
without having to set specific alignment options. You can simply double-click where you want the 
title to appear. 
 
When the Click and Type feature is active, the mouse pointer appears as an I-beam with an 
alignment symbol attached; this alignment symbol changes to reflect the corresponding alignment 
area as you drag the mouse pointer across any blank line. To enter text, you simply point to the 
location in the line where you want to enter the text, double-click, and type. 
 
The Click and Type feature is only available in the Print Layout or Web Layout views. 
Depending upon the location in which you want to use the Click and Type feature, you may first 
have to click in any blank area of the line to activate it. 
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In order to use the Click and Type feature, the Enable click and type 
option on the Edit page in the Options dialog box must be selected. 

  

 
If you double-click in a blank line, but do not insert text, Word does not 
save the alignment setting. 

  
 

 Procedures 

1. Switch to Print Layout or Web Layout view. 

2. Click once in any blank area of the line in which you want to insert text. 

3. Point to the location in the line where you want to insert the text. 

4. Double-click at the location in the line where you want to insert text. 

5. Type the desired text. 

 

REVEALING FORMATTING 

 Discussion 
The Reveal Formatting task pane displays the attributes for the selected document text. Attributes 
are grouped under headings, the most common being Font, Paragraph, and Section. 
 
The Font heading shows the name and point size of the font, as well as the language of the text. If 
other font attributes have been applied (for example, highlighting), they will also be listed here. The 
Paragraph heading displays the alignment and indentation of the current paragraph. In addition, if 
other paragraph attributes have been added (such as spacing or tabs), they will also be displayed. The 
Section heading displays attributes for margins, layout, and paper size. 
 
You can expand and collapse the Font, Paragraph, or Section headings to view or hide the 
attributes. The underlined attributes under each heading are links to the corresponding dialog boxes; 
when you click a link, the corresponding dialog box opens and you can make changes as desired. 
 
You can also use the task pane to compare the differences in formatting between two text selections. 
 

  

 
If the task pane is already open, you can use the Other Task Panes list 
arrow to change task panes. 

  

 
Other attribute headings such as Table, Cell, and Bullets and Numbering 
will appear if the document contains a table or a numbered or bulleted list. 

  
 



 

VU Instructional Technologies Page 23 
 

 Procedures 

1. Select the Format menu. 

2. Select the Reveal Formatting command. 

3. Select the text whose formatting you want to view. 

4. Click in the Reveal Formatting task pane to expand the heading containing the 
attributes you want to view, if necessary. 

5. Click the link for the formatting you want to change. 

6. Make the desired formatting changes. 

7. To compare text, select the first text to be compared. 

8. Select the Compare to another selection option. 

9. Select the comparison text. 

 
 

USING THE AUTOCORRECT OPTIONS BUTTON 

 Discussion 
The AutoCorrect Options button appears as a hollow, blue bar when you point to or position the 
insertion point near text that was automatically corrected. When you point to the blue bar, the 
AutoCorrect Options button appears. You can use available AutoCorrect options to change the text 
back to what was originally typed, have AutoCorrect stop automatically correcting the text, or access 
the AutoCorrect Options dialog box. 
 

  

 
AutoCorrect can capitalize the first word in a sentence, the days of the week, 
and the first letter in a table cell. You can turn these options on or off by 
selecting the Tools menu, the AutoCorrect Options command, and the 
applicable option on the AutoCorrect page. 

  
 

 Procedures 

1. Point to text that has been AutoCorrected. 

2. Point to the blue bar under the AutoCorrected word. 

3. Click the AutoCorrect Options button. 

4. Select the desired option. 
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TYPING A NUMBERED OR BULLETED LIST 

 Discussion 
There may be times when you need to include a numbered or bulleted list in a document. Numbered 
lists are often sequential items or items listed in order of importance. 
 
One way to create a numbered list is to use the AutoFormat as you type feature, which applies 
numbers or bullets as you type. Whenever you type a 1 (Arabic or Roman) or an A (uppercase or 
lowercase) and a period ( . ), dash ( - ), or parenthesis ( ) ) followed by a space or tab indent and then 
text, Word assumes you want to sequentially list the items. Whenever you type an asterisk (*) 
followed by a space or a tab indent and then text, Word assumes you want to create a bulleted list. 
Thereafter, each time you press [Enter], the next applicable number or letter in the sequence appears 
in a numbered list or another bullet appears in a bulleted list. 
 
After typing the first line of numbered or bulleted text and pressing [Enter], the AutoCorrect 
Options button appears. At this point, you can accept the AutoFormat and continue typing your list, 
or you can use the AutoCorrect Options list to undo the previous automatic list formatting or to end 
the list on the current line. 
 

 
You can also disable numbering and bullets after the last list item by 
pressing [Enter] and then pressing [Backspace] or by pressing [Enter] 
twice. 

 
Once you have created a numbered or bulleted list, you can view the format 
in the Styles and Formatting task pane. You can then apply the list format 
to other text in the document. 

  

 
You can permanently disable the AutoFormatting of numbered and bulleted 
lists by selecting Stop Automatically Creating Numbered Lists or Stop 
Automatically Creating Bulleted Lists from the AutoCorrect Options 
list. 

  
 

 Procedures 

1. Position the insertion point where you want to begin the numbered list. 

2. To create a numbered list, type the number or letter you want to begin the list; to 
create a bulleted list, type an asterisk (*). 

3. Add the desired spacing or punctuation.  

4. Type the desired text for the first list item. 
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5. Press [Enter]. 

6. Enter additional list items as desired. 

7. To turn off numbering or bulleting after the last list item, press [Enter] twice. 

 

ADDING NUMBERS OR BULLETS TO TEXT 

 Discussion 
Word can create a numbered or bulleted list from existing text. You can use the Numbering button 
on the Formatting toolbar to have Word number each paragraph of the selected text sequentially, 
beginning with the number 1. Alternately, you can use the Bullets button to have Word add a bullet 
to each paragraph of the selected text. 
 

  

 
If the document contains a numbered list above the current list, the 
AutoCorrect Options button appears, allowing you to continue the 
numbering sequence from the previous list or restart the numbering. 

  
 

 Procedures 

1. Select the text to which you want to add numbers or bullets. 

2. Click the Numbering button  to add numbers or the Bullets button  to 
add bullets to the selected text. 

 

USING LIST STYLES 

 Discussion 
Word allows you to create and customize bullet and numbering styles. You can create a new style 
from scratch, or you can edit an existing style and save it as a new style. 
 
You can use the List Styles feature to create a new style. This feature allows you to define a style for 
each level of your bulleted or numbered list. This is particularly useful when you use a bullet and 
numbering style consistently and have to reformat it each time. Images and different font styles can 
be assigned to any level of your custom bullet or numbering style. 
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You can also use the Styles and Formatting task pane to modify the current 
bullet or numbering style. Select the text of the style you want to modify, 
and then select the Modify command from the drop-down list of the style to 
be changed. 

  

 
To make a new bullets and numbering style available to other documents, 
you must add it to the template by checking the Add to template option in 
the Modify Style dialog box. 

  
 

 Procedures 

1. Select the list items of which you want to change the bullets or numbers. 

2. Select the Format menu. 

3. Select the Bullets and Numbering command. 

4. Select the List Styles tab. 

5. Select Add. 

6. Type the desired name for the list style. 

7. To create a picture bullet, select the Insert Picture button. 

8. Select the desired image. 

9. Select OK. 

10. Select the Apply formatting to list. 

11. Select the desired level. 

12. To create a symbol bullet, select the Insert Symbol button . 

13. Select the Font list. 

14. Select the desired font. 

15. Select the desired symbol. 

16. Select OK to close the Symbol dialog box. 

17. Select OK to close the New Style dialog box. 

18. Select OK. 

 



 

 

LESSON 5 -  
USING STYLES  
 

REVEALING STYLES 

 Discussion 
A style is a group of formatting attributes that are saved with a style name. There are four types of 
styles in Word 2002: character, paragraph, table, and list. You can apply styles as you type, or you 
can apply styles to existing text. Applying a style adds all the formatting attributes contained in that 
style to the selection. 
 
Styles can be created, changed, and applied using the Styles and Formatting task pane. You can 
also use the task pane to view the style applied to selected text. Using the style’s shortcut menu, you 
can select all the instances of a style, modify the style, delete a user-created style, or update the 
attributes in a style to match the current selection. 
 

  

 
The Styles and Formatting button is a toggle and can be used both to open 
and close the task pane. 

  

 
You can also open the Styles and Formatting task pane by selecting the 
Format menu and the Styles and Formatting command. 

  
 

 Procedures 

1. Click the Styles and Formatting button  on the Formatting toolbar. 

2. Select the Show list at the bottom of the task pane. 

3. Select Available styles. 

4. To view the style applied to specific text, position the insertion point in the 
applicable text. 

5. To find all text formatted with a specific style, right-click the style you want to 
find in the Pick formatting to apply list. 

6. Select the Select All # Instance(s) option. 
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APPLYING CHARACTER AND PARAGRAPH STYLES 

 Discussion 
Word supplies several different built-in styles for each of the four style types; character, paragraph, 
table, and list. 
 
A character style is applied to selected text within a paragraph and affects aspects such as the text 
font type and size, as well as effects such as bold, italic, and small caps. Word provides several 
different built-in character styles, including Emphasis and Strong. 
 
Whereas a character style is applied to specific text, a paragraph style is applied to an entire 
paragraph. Paragraph styles affect all aspects of a paragraph’s appearance, including alignment, tab 
stops, line spacing, indentation, and borders. Paragraph styles, however, can also contain character 
formatting. 
 
Word comes with several built-in paragraph styles. The most commonly used style is Normal. For 
example, you can use the Normal style for the body of a letter. Other commonly used styles include 
Heading 1, Heading 2, Heading 3, and Body Text. You can also create your own styles. Although 
some styles include the word Heading in them and are designed to be used for document headings, 
you can use them for other situations as well. 
 
A table style applies border, alignment, and shading to a table; a list style applies consistent bullets, 
numbering, and indentation to a list. The symbol next to a style name indicates which type of style it 
is: 
 

Style Type Symbol 

Character  

Paragraph  

Table  

List  
 
 

  

 
When you display All styles from the Show list, the most recently applied 
styles appear at the top of the Pick formatting to apply list, as well as in 
their correct alphabetic sequence within the list. 

  
 

 Procedures 

1. Open the Styles and Formatting task pane. 

2. Select the Show list at the bottom of the task pane. 
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3. Select All styles. 

4. To apply a character style, select the text you want to format. 

5. Click the character style you want to apply. 

6. To apply a paragraph style, select the paragraph you want to format. 

7. Click the paragraph style you want to apply. 

 

EDITING AN EXISTING STYLE 

 Discussion 
If you format text with a particular style and later decide that you want to change some of the style 
attributes, you can use the Styles and Formatting task pane to easily modify the style. Modifying a 
style allows you to reformat all text using that style at one time, without having to change each 
instance individually. 
 
When you edit a style, you change its formats (such as font attributes, paragraph settings, tabs, and 
borders). You can modify styles you have created, as well as built-in styles. For example, if you 
prefer to use the Tahoma font for your document text, you can change the font of the Normal style 
to Tahoma. 
 

  

 
You can also modify a style by example. First, apply the desired formatting 
to text and then select it. Right-click the style you want to modify in the 
Styles and Formatting task pane and select Update to Match Selection. 

  
 

 Procedures 

1. Open the Styles and Formatting task pane. 

2. Select the Show list at the bottom of the task pane. 

3. Select Available styles. 

4. Right-click the style you want to modify. 

5. Select Modify. 

6. Select Format. 

7. Select the type of formatting you want to modify. 

8. Modify the formatting as desired. 

9. Select OK. 
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10. Make additional formatting changes as desired. 

11. Select OK. 

 

CLEARING FORMATS AND STYLES 

 Discussion 
You can use the Clear Formatting command to remove formatting and styles from text. When you 
remove all formatting and styles from text, it adopts the attributes of the Normal style. You can 
remove formatting and style from a single instance or from all instances of that formatting or style. 
 
The Clear Formatting command appears at the top of the Pick formatting to apply list in the 
Styles and Formatting task pane whenever the Show option is set to Available formatting, 
Formatting in use, or Available styles. Since the Normal style is a paragraph style, all font, 
paragraph, tab, border, language, and numbering formats are returned to those defined by the 
Normal style. 
 
If you clear formatting from text formatted with a character style, the text adopts the formatting of 
the paragraph around it, rather than that of the Normal style. 
 

  

 
Applying the Normal style has the same effect as selecting the Clear 
Formatting command. 

  

 
You can also clear formats by selecting the Edit menu, the Clear submenu, 
and the Formats command. 

  
 

 Procedures 

1. Open the Styles and Formatting task pane. 

2. Select the Show list at the bottom of the task pane. 

3. Select Available formatting, Formatting in use, or Available styles. 

4. Select the text containing the formatting or style you want to clear. 

5. Select Clear Formatting at the top of the Pick formatting to apply list. 
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DELETING A STYLE 

 Discussion 
If you no longer use a particular style, you can delete it from the document. When you delete a style, 
the Normal style is applied to any text formatted with the deleted style. 
 

  

 
If you accidentally delete a style, you can use Undo to reverse the action. 

  

 
You cannot use the Style box on the Formatting toolbar to delete a style. 

  
 

 Procedures 

1. Open the Styles and Formatting task pane. 

2. Select the Show list at the bottom of the task pane. 

3. Select Available styles or All styles. 

4. Right-click the style you want to delete in the Pick formatting to apply list. 

5. Select Delete. 

6. Select Yes. 



 

 

LESSON 6 -  
USING NEW GRAPHIC FEATURES  
 

CREATING A DRAWING OBJECT 

 Discussion 
You can enhance a document by drawing an object such as a rectangle, oval, line, arrow, or polygon 
directly in it. Arrows, for example, can be used to point to important items; rectangles or ovals can 
be used to draw attention to specific items; and lines can be used to create divisions within a 
document. Drawing objects are created using the buttons on the Drawing toolbar. 
 
As soon as you click a drawing object button on the Drawing toolbar, Word inserts a drawing 
canvas. The drawing canvas makes it easier to create and maintain complex drawings. All objects 
drawn within the confines of the drawing canvas are kept together as one unit. Although drawing 
objects are stored permanently on the drawing canvas, you can drag objects on or off the canvas as 
desired; Word allows objects to be stored in the document text as well. 
 
When a drawing object button is activated, the mouse pointer changes into a crosshair. The center of 
the crosshair represents the outer border of the object. In addition, Word switches to Print Layout 
view as soon as you click a drawing object button. 
 
Drawing objects can be moved or copied to any location in a document, and any objects stored on a 
drawing canvas are moved or copied as one unit. Once drawn, objects can be modified to change 
their shape, size, color, fill, and pattern, as well as a number of other attributes. 
 

  

 
You can hold the [Shift] key as you drag to draw a square with the 
Rectangle button or a circle with the Oval button. Simply clicking in the 
document after selecting a drawing object button inserts the object in a 
predefined size. 

  

 
To draw more than one object of the same type, double-click the applicable 
drawing object button. After you have drawn the desired number of objects, 
press the [Esc] key or click the drawing object button again to deactivate it. 

  

 
Word provides a grid of horizontal and vertical lines to help you create and 
align objects. From the Drawing toolbar, select the Draw menu, the Grid 
command, and the Display gridlines on screen option; then enter the 
desired amount of spacing between the vertical and horizontal grid lines. 

  
 



 

VU Instructional Technologies Page 33 
 

 Procedures 

1. Switch to Print Layout view. 

2. Click the Drawing button  on the Standard toolbar to display the Drawing 
toolbar. 

3. Click the desired drawing object button. 

4. Drag in the drawing canvas to position and size the object as desired. 

 

USING THE DRAWING CANVAS 

 Discussion 
The drawing canvas acts as a frame in which you can create and arrange multiple drawing objects. 
 
You can use the buttons on the Drawing Canvas toolbar to change the size of the drawing canvas. 
The Fit button resizes the canvas tightly around the objects within it. Conversely, the Expand button 
enlarges the canvas, creating more space between the border of the drawing canvas and the objects 
within it. Each time you click the Expand button, the canvas gets larger. These options only change 
the size of the drawing canvas; the size of the drawing objects within it are not affected. 
 
The drawing canvas helps keep the objects in a complex drawing together and allows you to move 
and resize all the objects as one. Using the Scale Drawing button, you can resize all the objects 
within the drawing canvas at the same time. When you move the drawing canvas, all the objects 
remain in their relative positions and move with the canvas. However, you cannot move the drawing 
canvas if the In Line With Text option is enabled from the Text Wrapping menu on the Drawing 
Canvas toolbar. Selecting any other text wrapping option allows you to freely move the drawing 
canvas. 
 

  

 
The options on the Text Wrapping menu are not available if an object is 
selected in the drawing canvas. To deselect all objects, click in any blank 
area of the drawing canvas. 

  

 
To display the Drawing Canvas toolbar, right-click in the canvas and select 
the Show Drawing Canvas Toolbar. 

  

 
You can move and resize multiple objects as one object without using the 
drawing canvas by grouping them. Select all the objects (using the Shift key 
as you select each one) you want to group, and then select the Group 
command from the Draw menu on the Drawing toolbar. 
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 Procedures 

1. Select any object in the drawing canvas. 

2. Click the  Fit button on the Drawing Canvas toolbar to fit the drawing canvas 
to its contents. 

3. Click the  Expand button as desired to enlarge the drawing canvas. 

4. Select the  Scale Drawing button to resize the contents in the drawing canvas. 

5. Drag any sizing handle as desired to resize the objects.  

6. Select the  Scale Drawing button to disable scaling. 

7. Select the Text Wrapping button . 

8. Select the desired text wrapping option. 

9. Drag the drawing canvas to the desired position. 

 

DRAWING WITHOUT THE DRAWING CANVAS 

 Discussion 
There are times when it may be more efficient to draw an object without using the drawing canvas. 
The drawing canvas was designed to help control the layout of text and diagrams in documents, as 
well as to manage multiple objects. If you are inserting only one object, you can do this without the 
drawing canvas. 
 
To draw a single object without the drawing canvas, you can either draw the object outside of the 
drawing canvas, or you can press the [Esc] key when the drawing canvas first appears, before you 
draw the object. This removes the drawing canvas from the document, but only for the current 
instance. If you subsequently click a drawing object button or select an AutoShape from the 
Drawing toolbar, a drawing canvas will again appear. 
 
In addition, pressing [Esc] hides the drawing canvas for an existing drawing, but does not remove it. 
When you reselect the object, the drawing canvas reappears. 
 
You can permanently disable the drawing canvas for all new drawings. If you do so, the drawing 
canvas no longer appears when you click a drawing object button or select an AutoShape from the 
Drawing toolbar. However, existing drawing canvases are not affected. 
 

  

 
To disable the Drawing Canvas feature, select the Tools menu and the 
Options command On the General tab, deselect the Automatically create 
drawing canvas when inserting AutoShapes option. 
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You can drag an existing object off its drawing canvas and move it to any 
desired position. You can then select the drawing canvas and press the 
[Delete] key to delete it. 

  
 

 Procedures 

1. Select the desired drawing button on the Drawing toolbar. 

2. Press [Esc]. 

3. Drag to draw the desired object. 

 

CREATING WATERMARKS 

 Discussion 
A watermark is a graphic or text that appears behind the text and objects on a page. Watermarks are 
commonly used to identify the status of a document (DRAFT, for example). When you add a 
watermark to a page, you can apply it to all pages of the document or just to the current section. 
 
You can scale a picture watermark to increase or decrease its size. If you create a text watermark, 
you can select a text option from the Text list or type the text you want to use into the Text box. You 
can also select the font, font size, and font color of the text, as well as position it as desired on the 
page. 
 
To be effective, the contrast and brightness of the watermark should be adjusted using either the 
Washout or Semitransparent options, so that the document text is legible. 
 
You can access the watermark image after it has been inserted by displaying the Header area. 
 

  

 
Colors and fill effects available in the Backgrounds submenu are usually 
used to add interest to a document and are for viewing only, not printing. 

  

 
Selecting the Apply button in the Printed Watermark dialog box allows you 
to preview the watermark in your document. 
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 Procedures 

1. Select the Format menu. 

2. Point to the Background command.  

3. Select the Printed Watermark command. 

4. To use a picture as a watermark, select the Picture watermark option. 

5. Click Select Picture. 

6. Select the Look in list. 

7. Select the drive containing the desired picture file. 

8. Open the folder containing the desired picture file. 

9. Select the picture you want to insert. 

10. Select Insert. 

11. Select OK. 

 

INSERTING A CLIP ART IMAGE 

 Discussion 
You can include pictures in a Word document. A picture can enhance a document by depicting an 
idea that may be difficult to describe or by making the document more visually appealing. You can 
use the Insert Clip Art task pane to insert clip images. 
 
To find a clip, enter a word related to the type of clip you want to insert in the Search text box. 
Words used in a search are called keywords. If you want to insert a clip, but you are not sure which 
one you want to add, you can perform a keyword search for clips. If your document deals with 
sporting goods, for example, you can use the keyword sports to search the Clip Organizer; any clip 
pertaining to sports will be found. 
 
You can limit searches to a specific type of collection or media file by selecting the corresponding 
option under the Other Search Options area. If you have changed search criteria, but have not yet 
performed the search, you can use the Restore button to return to the previous settings. 
 
After entering your search criteria and clicking the Search button, thumbnails of all clips found 
based on the search criteria appear in the Results box. You can expand the Results box by clicking 
the button above it. Clicking the button again returns the Results box to its previous size. 
 
When you point to a clip, a ScreenTip displays the keywords related to that image, its size in pixels, 
its file size, and its graphic format. Clicking directly on a clip inserts it into your presentation at the 
insertion point. You can use the list of options that appears when you right-click a clip or click its 
drop-down arrow to copy or delete the clip, edit the clip keywords, find clips with a similar style, or 
view the clip properties. 
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If the list of found clips does not suit your needs, you can use the Modify button to modify the 
search or to create a new one. 
 

  

 
Not all Clip Art has been installed on your machine. If you want to have 
additional Clip Art installed, contact the Helpdesk at x97777. 

  

 
You can also open the Insert Clip Art task pane by selecting the Insert 
menu, pointing to the Picture command, and then selecting the Clip Art 
command. 

  

 
If you know the location of the clip you want to insert, you can select that 
location from the Search in list on the Insert Clip Art task pane. 

  

 
Keywords are editable; you can use the Preview/Properties dialog box to 
add keywords to a clip or to remove keywords from it, if desired. You can 
also add clips to the Clip Organizer, if desired. 

  
 

 Procedures 

1. Position the insertion point where you want the clip to be inserted. 

2. Click the Insert Clip Art button  on the Drawing toolbar. 

3. Select the Search text box. 

4. Type the desired keyword. 

5. To limit the search, click the Search in arrow. 

6. Click the plus sign next to each collection you want to expand. 

7. Click check boxes as desired to select the collections you want to search or 
deselect the collections you do not want to search. 

8. Press [Esc] to close the Search in list. 

9. To limit what to search, click the Results should be arrow. 

10. Click the plus sign next to the media types you want to expand. 

11. Click check boxes as desired to select the media you want to search or deselect 
the media you do not want to search. 

12. Press [Esc] to close the Results should be list. 

13. Select the Search button. 

14. Click the desired clip to insert it at the insertion point. 
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FORMATTING PICTURES 

 Discussion 
Although pictures are inserted with default settings, you can change these settings at any time. You 
can change the size, alignment, fill color, and text wrapping style for inserted graphics. 
 
The text wrapping style of a graphic determines whether or not you can drag the object 
independently of the text in which it is positioned. The In line with text option keeps the graphic 
image within the document text. To be able to freely move an object on the page, you may have to 
select another text wrapping style. 
 
The Web page in the Format Picture dialog box is new to Word 2002. If the document containing a 
picture is going to be saved as a web page, you can use the Web page to enter the text that will 
appear while the browser is loading the picture or if the picture does not load. 
 

  

 
You can also open the Format Picture dialog box by clicking the Format 
Picture button on the Picture toolbar. 

  

 
The options available on the Wrapping page in Word 97 are now available 
in one of two places: the Layout page in the Format Picture dialog box or 
the Advanced Layout dialog box, available from the Layout page.  

  
 

 Procedures 

1. Switch to Print Layout view, if necessary. 

2. Right-click the image you want to format. 

3. Select the Format Picture command. 

4. Select the tab with the settings you want to change. 

5. Select the desired options. 

6. Select OK. 
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LESSON 7 -  
CONVERTING WORDPERFECT FILES TO WORD XP 
 

 Discussion 
 

Your WordPerfect files can be read by Microsoft Word XP. There are two ways to open a 
WordPerfect file using MS Word. The first is to open the file from within Word. The second is to 
double-click on the file from within the Windows Explorer (My Computer or My Documents). The 
procedures for both are detailed below. 

 

OPENING A WORDPERFECT FILE FROM WITHIN MICROSOFT 
WORD 

 
1. Open MS Word. 
2. Click either File, Open or More documents… from the New Document task pane. 
3. Make sure that the Files of Type section at the bottom of the box says All Files, not All Word 

Documents. 
4. Locate the WordPerfect file that you want to open and double-click on it. 
5. Once you save this file, the document will be converted to Word format. Any conversion 

problems that may have occurred (e.g., footnotes did not convert properly) will be permanently 
saved the minute you hit Save and convert the file.  

6. Click the Save button to complete the conversion. 
7. You will the following message: 

 
 

8. If you answer Yes, the file will be converted to Word format. You will still be able to open the 
file in WordPerfect, but any changes made to the file during the conversion to Word will be 
undoable at that point. 

9. If you are not sure that you want to overwrite the original WordPerfect file to Word format, you 
could click Save As… instead of Save, giving the converted document a different name than the 
original. Otherwise, your original WordPerfect file will be overwritten with the new Word file. 

 
Note: When you convert (and overwrite) a WordPerfect file to Word format using the directions 
above, you do not change the .wpd file extension at the end of the filename (which you cannot see 
because the file extensions are not set to be visible on your computer). Therefore, your computer 
will still recognize the file as a WordPerfect file and will denote the file with a generic Windows 
icon instead of the Word “W” icon in the Open dialog box. However, you can be assured that the 
file has been converted to the Word format. 
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OPENING A WORDPERFECT FILE FROM THE WINDOWS 
EXPLORER 
 

1. Open either My Documents or My Computer and locate the WordPerfect file that you want to open in 
Word. 

2. Double-click on the file. You will get the following message: 
 

 
 
3. Choose Select the program from a list and click OK.  

 

 
 
4. If Microsoft Word is listed under Recommended Programs:, then select it by clicking on it once. 

Otherwise, scroll down the Other Programs: list and click on Microsoft Word there. 
5. Check the Always use the selected program… box and click OK. 
6. The file will open in MS Word and now all other WordPerfect files will open in MS Word if you 

attempt to open them from outside of Word. 
7. To finish the conversion from WordPerfect to Word, you must save the file. See steps 6-9 above to learn 

how to do this. 
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